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Create Forecast Positions - HRS6285

Position Management > Utilities > Create Forecast Positions

This utility allows the user to create new forecast position records based on existing position
records.

If updating tables, create an export using Export PMIS Tables prior to using this utility.

Create forecast positions:

❏ Use the following options to create forecast positions:

Note: By default, all fields on this page are selected. You can clear a selected field by unselecting
the individual check box.

Include Proposed Positions
More Forecast Conversion Actual Payments to Position Max Payments (Also includes
remaining payments if Position occupied)
Move Forecast Conversion Actual Payments to Supplement Max Payments
Reset Supplement Amounts based on Extra Duty code Table Default Amount
Move Forecast Conversion Max Days to Supplement Max Days
Move Supplement Max Days to Supplement Extra Days (occupied only)
Move Supplement Max Payments to Supplement Remaining Payments

❏ Click Execute to execute the process.

Notes:

All positions and supplement positions are processed through the forecast conversion
tables in order to create the new forecast position records with the associated distributions.
If the Recalculate field is selected for a supplement position, and the position is not based
on a regular position, the table amount for the extra duty is applied to the position record.
If the Recalculate field is not selected, the salary amount in the supplement position is not
changed.
The school year value for the new position records is based on the value displayed in the
Next Year field on the District Administration > Options > PMIS District Options page.
If the salary concept is different in the current and next year job tables, positions with that
job are not processed.
A warning message is displayed if a first pay date/calendar code, or an extra duty code
does not exist for a position in the forecast conversion tables; however, the forecast
position record will still be created for the position.
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A warning message is displayed if an employee has two or more regular positions that
exceed 100% of the day and the LEA does not have the Ignore % of Day field selected on
those positions. This warning does not apply to supplement positions.

❏ Under Processing Reports, the following reports are available:

Error Listing
Create Forecast Positions Report

❏ Select a report:

Select the check box next to the individual report name.
Click Select All to select all reports.
Click Unselect All to clear all selections so that no reports are selected.

❏ Click Generate Reports. The system displays the first report selected. Review the report.

❏ Click Continue to view the next report. Or, click Return to return to the reports selection page.

❏ Click Process to proceed. You are prompted to create a backup.

❏ Click Cancel to return to the Create Forecast Positions page without creating any forecast
positions.

https://help.ascendertx.com/business/doku.php/general/printreport
https://help.ascendertx.com/business/doku.php/general/pmis_backup
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Export PMIS Tables - HRS7100

Position Management > Utilities > Export PMIS Tables

This utility is used to export current and next year position management tables for all pay
frequencies including PMIS District Options. The export includes active/inactive positions and
supplemental positions.

You can use the Position Management > Utilities > Import PMIS Tables page to import the tables.

Note: If data is changed after the export and then imported, those changes are not included.

Export position management tables:

Field Description
Export File Name This field is preset and display only. The export file name has the format

dbcccddd_PMIS_mmddyyyy.rsf, where cccddd is the county-district number,
PMIS indicates position management, and mmddyyyy is the current date.

Enter the Password
to be used for the
Archive

Type a password for the exported file.

❏ Click Execute. The tables are exported and a message is displayed indicating that the export
process was completed successfully.
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Import PMIS Tables - HRS7100

Position Management > Utilities > Import PMIS Tables

This utility is used to import position management tables that were previously exported using the
Position Management > Utilities > Export PMIS Tables page.

When the Position Management import is complete, all records (regardless of pay frequency and
current/next year flag) are imported.

Note: If data is changed after the export and then imported, those changes are not included.

Import position management tables:

❏ Click Choose File. Locate and select the folder on your computer or network and click Open. The
file name is displayed.

❏ Click Cancel to close the dialog box without selecting a file.

Enter the Password used for the Archive Type a required password for the exported file.

❏ Click Execute to start the import function.

A message is displayed indicating that you are about to import position management tables and
confirming that you want to continue.
Click Yes to continue the import. Or, click No to cancel the import.

A message is displayed indicating that the import process completed successfully. Click OK.
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Import Position Records - HRS7100

Position Management > Utilities > Import Position Records

This page is used to import position records or distribution records into the position management
tables. When importing position records, ensure the payroll frequency of the archived file is the
same as that of the logged-on payroll frequency.

Notes:

If importing current year records, you must be logged on to a current year pay frequency.

If importing forecast records, you must be logged on to a next year pay frequency.

Position Records File Layout

Review the Checklist - Import Position Data to PMIS for additional information.

Import position records:

❏ Under Record Type, select one of the following:

Position Records
Distribution Records

❏ Click Choose File. Locate and select the file on your computer or network, and click Open. The file
name is displayed next to Choose File.

❏ Click Execute to start the import function. A preview report is displayed. Review the report.

❏ Click Continue to continue the process. Or, click Cancel to return to the Import Position Records
page.

❏ Click Process to proceed.

A message is displayed indicating that the import process completed successfully. Click OK.

https://help.ascendertx.com/interfaces/doku.php/business/position_records
https://help.ascendertx.com/business/doku.php/general/business/overview_guide/humanresources_pmis_process_importing_position_data
https://help.ascendertx.com/business/doku.php/general/printreport
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Mass Delete Forecast Positions - HRS6285

Position Management > Utilities > Mass Delete Forecast Positions

This utility allows you to delete all forecast records at one time.

You must be logged on to a next year pay frequency to access this utility.

Create an export using Export PMIS Tables prior to using this utility.

Modify a record:

Field Description
Select Positions only (P),
Supplements only (S) or
blank for ALL

Select an option.

Select Position Statuses or
blank for ALL

Type the position statuses, separating multiple position statuses
with a comma but no space (e.g., A,I). Or, click  to search for
position statuses. Otherwise, leave blank to use all position statuses.

Select Position School Years
or blank for ALL

Type the position school years, separating multiple position school
years with a comma but no space (e.g., 2014,2015). Or, click  to
search for position school years. Otherwise, leave blank to use all
position school years.

Select First Pay Date Codes
or blank for ALL

Type the pay date codes, separating multiple pay date codes with a
comma but no space (e.g., NY4,NY6). Or, click  to search for pay
date codes. Otherwise, leave blank to use all pay date codes.

Select Extra Duty Codes or
blank for ALL

Type the extra duty codes, separating multiple extra duty codes with
a comma but no space (e.g., 08,20,A2,TF). Or, click  to search for
extra duty codes. Otherwise, leave blank to use all extra duty codes.

Select Positions or blank for
ALL (Includes ALL billets for
selected positions)

Type the position codes, separating multiple position codes with a
comma but no space (e.g., PRIN,T187). Or, click  to search for
position codes. Otherwise, leave blank to use all position codes.

Select Positions/Billets or
blank for ALL

Type the position/billet codes, separating multiple position/billet
codes with a comma but no space (e.g., PRIN/00001,PRIN/00006).
Or, click  to search for position/billet codes. Otherwise, leave blank
to use all position/billet codes.

Select Supplement
Positions or blank for ALL
(Includes ALL billets for
selected supplement
positions)

Type the supplement position codes, separating multiple
supplement position codes with a comma but no space (e.g.,
PRIN,T187). Or, click  to search for supplement position codes.
Otherwise, leave blank to use all supplement position codes.

Select Supplement
Positions/Billets or blank for
ALL

Type the supplement position/billet codes, separating multiple
supplement position/billet codes with a comma but no space (e.g.,
PRIN/00001,PRIN/00006). Or, click  to search for supplement
position/billet codes. Otherwise, leave blank to use all supplement
position/billet codes.

https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amassdeleteforecastpositions
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amassdeleteforecastpositions
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amassdeleteforecastpositions
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amassdeleteforecastpositions
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amassdeleteforecastpositions
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amassdeleteforecastpositions
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amassdeleteforecastpositions
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amassdeleteforecastpositions
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❏ Click Execute to execute the process.

The following reports are available:

Mass Delete Forecast Positions Process Error Listing
Mass Delete Forecast Positions by Employee Name
Mass Delete Forecast Positions by Campus
Mass Delete Forecast Positions by Position/Billet

❏ Click Generate Reports . The system displays the first report selected. Review the report.

❏ Click Continue to view the next report. Or, click Return to return to the reports selection page.

❏ Click Process to process the records. You are prompted to create a backup.

After the export process is completed, the actual update is performed. If the update is successful,
a message is displayed indicating that the mass delete update was processed successfully.

❏ Click Cancel to return to the Mass Delete Forecast Positions page without processing.

https://help.ascendertx.com/business/doku.php/general/printreport
https://help.ascendertx.com/business/doku.php/general/pmis_backup
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Mass Delete PMIS History - HRS6285

Position Management > Utilities > Mass Delete PMIS History

This utility allows you to delete all PMIS history records for a selected school year at one time.

Create an export using Export PMIS Tables prior to using this utility.

Delete PMIS history records:

Field Description
Select School Year Type the four-digit school year for which you want to delete PMIS history

records.

Note: You must enter a prior school year. The value cannot be the current school year (i.e., the
value in the Current Year field on the District Administration > Options > Position Management
page).

❏ Click Execute to process the deletion of records. You are prompted to create a backup.

After the export process is complete, the actual update is done. If the update is successful, a
message is displayed indicating that the mass delete of PMIS history records was processed
successfully.

https://help.ascendertx.com/business/doku.php/general/pmis_updatesalarytables_backup


Business

2024/05/14 22:26 13 Position Management: Utilities

Mass Update Forecast Using First Pay Date
Codes - HRS6280

Position Management > Utilities > Mass Update Forecast Using First Pay Date Codes

This utility is used to update position records based on the first pay date code and the calendar
code for forecast records. For example, this utility could be used when you need to move a group of
13-month teachers to a regular group of 12-month teachers.

You must be logged on to a next year pay frequency to access this utility.

This utility is for forecast records only.

Create an export using Export PMIS Tables prior to using this utility.

Mass update forecast records using first pay date codes:

The following fields are display only:

The First Pay Dt Cd indicates the code for the first pay date.
The Cal Cd indicates the two-digit locally assigned calendar code.
The Extra Duty Cd indicates the two-digit extra duty code of the additional job assignment, if
any.
The First Pay Date indicates the first pay date in the MMDDYYYY format (based on the first
pay date calendar code).
The Begin Dt indicates the calendar beginning date in the MMDDYYYY format.
The End Dt indicates the calendar end date in the MMDDYYYY format.
The Payoff Dt indicates the contract payoff date in the MMDDYYYY format.
The Max Days indicates the maximum number of days.
The Nbr Days Off indicates the number of days an employee is scheduled to work but did not.
The Actual Days indicates the number of days actually worked.
The Actual Pymnts indicates the number of pay dates for the calendar.
In the To First Pay Dt Cd field, type a first pay date code, or click  to select a new first pay
date code from a list. The field can be a maximum of three characters.
In the To Cal Cd field, type the calendar code, or click  to select a new calendar code from a
list. The field can be a maximum of two characters.

❏ Click Execute to execute the process.

The following reports are available:

Mass Update Using First Pay Date Codes Process Error Listing
Mass Update Forecast Positions by Employee Name
Mass Update Forecast Positions by First Pay Date Code
Mass Update Forecast Positions by Campus

https://help.ascendertx.com/business/lib/exe/detail.php/images/dropdown.gif?id=positionmanagement%3Autilities%3Amassupdateforecastusingfirstpaydatecodes
https://help.ascendertx.com/business/lib/exe/detail.php/images/dropdown.gif?id=positionmanagement%3Autilities%3Amassupdateforecastusingfirstpaydatecodes
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❏ Click Select All to select all reports. Or, click Unselect All to clear all check boxes so that no
reports are selected.

❏ Click Generate Reports. The system displays the first report selected. Review the report.

❏ Click Continue to view the next report. Or, click Return to return to the reports selection page.

❏ Click Process to mass update forecast records using first pay date codes. You are prompted to
create a backup.

After the export process is completed, the actual update is performed. If the update is successful,
a message is displayed indicating that the update was processed successfully.

https://help.ascendertx.com/business/doku.php/general/printreport
https://help.ascendertx.com/business/doku.php/general/pmis_backup
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Move Forecast to CYR Position and Payroll -
HRS6260

Position Management > Utilities > Move Forecast to CYR Position and Payroll

This utility is used to move payroll and position forecast records to the current year PMIS with the
same information that is set up in the next year PMIS records.

It also updates fields on the Employment Info, Pay Info, Job Info, and Distribution maintenance tabs.

This utility updates the Percent Day Employed field on the Personnel > Maintenance >
Employment Info tab.

When moving position records from forecast to current, ensure that the Accept Changes field is
not selected. The position records cannot be moved if the Accept Changes field is selected.

When running a simulation, the Accept Changes field must be selected. And, if the simulation is
run with the Update Forecast field set to Yes, the Accept Changes field is cleared after the
simulation is run.

Create an export using Export PMIS Tables prior to using this utility.

You must be logged on to a next year pay frequency to access this utility.

Notes: If you have not run the simulation live, a list of errors is displayed upon running this utility.
The move forecast to current process does the following:

Creates two historical records, an ending record for the position in the current year and a
beginning record for the position in forecast.
Updates the current year position records with the data in forecast.
Deletes all current year job and distribution records and replaces it with the data from
forecast.

PMIS Overtime Notes

If the employee’s position record has hours per day, the following overtime calculation is
used: overtime rate = (daily rate / hours per day) * 1.5, hourly rate = (daily rate / hours per
day).
If the employee’s position record hours per day is zero and the job code table has FTE Hours,
the following overtime calculation is used: overtime rate = (daily rate / (fte hours / 5) * 1.5,
hourly rate = (daily rate / (fte hours / 5).
If the employee’s position record hours per day is zero and the job code table has zero FTE
Hours, the following overtime calculation is used: overtime rate = (daily rate / standard hrs) *
1.5, hourly rate = (daily rate / standard hrs).

https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
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Move forecast records to current year:

Select Pay Frequency Click  to select the pay frequency where you want to move to
the current year. This is a required field.

Include Vacant Supplements Select to include the vacant supplement positions.

Recommendation: Do not select this field unless it is your final
move.

Validate Accounts against
General Ledger

This field is selected by default. Clear this field to not validate the
accounts against the general ledger.

Recommendation: Select this field if you are doing your first test
move. By doing so, the appropriate errors are generated to inform
you of incorrect account codes in PMIS. If not selected, those
account codes are moved to Payroll if each account component is
valid.

Update TRS Year Flag Select to update the TRS Year field on the Payroll > Staff/Job Pay
Data > Job Info tab.

Recommendation: Select this field if the employees being moved
will receive a contract payment prior to the first pay date of the
new school year (i.e., July and August starts).

Update Workers' Comp
Annual and Remaining
Payments

Select to update the WC Ann Pymts and WC Remain fields on
the Payroll > Staff/Job Pay Data > Job Info tab.

The WC Ann Pymts field indicates the number of annual workers'
compensation payments for the contract period and the WC
Remain field indicates the number of remaining workers'
compensation payments to be made during the contract period.

Add Additional Workers'
Comp Payments

Type the number of additional workers' compensation payments.
The field accepts any value between 0-9.

This field is helpful as it can be difficult to identify which months
have a third payroll for the biweekly frequency. You can use this
field to add one or two to the contract months times two.

Select State Minimum Salary
Table (CYR/NYR)

Click  to select the current year or next year. This is a required
field.

This selection determines which salary table is referenced when
calculating the state foundation salary.

Select First Pay Date Codes
or blank for ALL

Select the first pay date codes that begin their new contract
payout. Type the pay date codes, separating multiple pay date
codes with a comma but no space (e.g., 1,17,88,A1). Or, click  to
search for pay date codes. Otherwise, leave blank to use all pay
date codes.

Include Extra Duty Select to include extra duty in the process. If not selected, no extra
duty will be processed even if extra duty codes are selected.

https://help.ascendertx.com/business/lib/exe/detail.php/images/dropdown.gif?id=positionmanagement%3Autilities%3Amoveforecasttocyrpositionandpayroll
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amoveforecasttocyrpositionandpayroll
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amoveforecasttocyrpositionandpayroll
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Select Extra Duty Codes or
blank for ALL

Select all of the supplements as only those supplements that are
tied to an employee being moved based on the first pay date code
will be selected. You can select a supplement even if it is tied to an
employee who you do not want to pay yet. Type the extra duty
codes, separating multiple extra duty codes with a comma but no
space (e.g., 08,20,A2,TF). Or, click  to search for extra duty
codes. Otherwise, leave blank to use all extra duty codes.

Select Positions or blank for
ALL (Includes ALL billets for
selected positions Blank for
ALL not processed when
Positions/Billets selected)

Type the position codes, separating multiple position codes with a
comma but no space (e.g., PRIN,T187). Or, click  to search for
position codes. Otherwise, leave blank to use all position codes.

Select Positions/Billets or
blank for ALL

Type the position/billet codes, separating multiple position/billet
codes with a comma but no space (e.g., PRIN/00001,PRIN/00006).
Or, click  to search for position/billet codes. Otherwise, leave
blank to use all position/billet codes.

Select Supplement Positions
or blank for ALL (Includes ALL
billets for selected
supplement positions Blank
for ALL not processed when
Supplements/Billets selected)

Type the supplement position codes, separating multiple
supplement position codes with a comma but no space (e.g.,
PRIN,T187). Or, click  to search for supplement position codes.
Otherwise, leave blank to use all supplement position codes.

Select Supplement
Positions/Billets or blank for
ALL

Type the supplement position/billet codes, separating multiple
supplement position/billet codes with a comma but no space (e.g.,
PRIN/00001,PRIN/00006 ). Or, click  to search for supplement
position/billet codes. Otherwise, leave blank to use all supplement
position/billet codes.

Clear Job Years Select to reset the job years to the default value (blank) on the
employee's job record.

If not selected and the employee's forecast position job code is the
same as the current year job master record, then the new job
record is populated with the values from the current year job
master record.

Clear Job Weekly Hours
Scheduled

Select to reset the weekly hours scheduled to the default value
(blank) on the employee's job record.

If not selected and the employee's forecast position job code is the
same as the current year job master record, then the new job
record is populated with the values from the current year job
master record.

❏ Click Execute to execute the process.

The following reports are available:

Move Forecast Process Error Listing Important errors
Error Message Description
Warning: The employee has
Contract Balance amounts not
equal to zero for current jobs.

The employee has not been paid off by payroll.

Failure: Position Accept
Changes Flag set to Y The position will not be moved to the current/payroll.

https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amoveforecasttocyrpositionandpayroll
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amoveforecasttocyrpositionandpayroll
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amoveforecasttocyrpositionandpayroll
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amoveforecasttocyrpositionandpayroll
https://help.ascendertx.com/business/lib/exe/detail.php/images/picklist_large.png?id=positionmanagement%3Autilities%3Amoveforecasttocyrpositionandpayroll
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Error Message Description
Failure: Emp Nbr must have one
position declared as primary.

The error does not necessarily reference the Primary Job
field on the position. If an employee has a regular position
and a supplement position, but there is an error that
causes the primary position to fail, this message often
indicates that there is only a supplement position to be
moved. It is recommended to review and correct any
errors that begin below this message about primary
positions. After making those corrections, run the process
again. This may resolve the primary job errors.

This error also occurs when calendars have not been
copied to the current year.

Warning: Emp Nbr has multiple
supplement positions for the
same job; however, one or more
of the following do not match:
Campus ID, Dept, TRS Status
Code, FTE Units, Incr Elig, Max
Paymts, FICA Elig, Unemp Elig,
EEOC, Workers Comp,
Supplement Extra Days or
Category Cd. The values from
lowest Supplement Position
Number/Billet may be used if
new rows are inserted for the
Pay Info and Job Info tabs.

This error indicates that the fields on the Payroll > Tables
> Salaries > Extra Duty tab do not match those selected
on a supplemental position.

Use the Position Management > Inquiry > PMIS Staff
Inquiry to determine the Position Number and Billet for
any supplemental positions for the employee. Then, use
the Position Management > Maintenance > PMIS
Supplement Modify page to retrieve the position and billet
and compare the fields on the position to the Payroll >
Tables > Salary > Extra Duty tab for the extra duty
number on the supplement. For example, in some cases
the W/C code on the position may not match the W/C code
on the table. Or, the Exp 373 field on the position may be
selected, but the Exp 373 on the table for that extra duty
code may not be selected. Either the table or the position
needs to be updated so that they both match. If changes
are made to the Extra Duty table, it is necessary to move
the table to the current year payroll before proceeding.

Update CYR Positions From Forecast - The error report lists any funds that need to be set up in
the Finance tables.
Update CYR Payroll From Forecast by Employee Name
Update CYR Payroll From Forecast by Campus ID

❏ Click Select All to select all reports. Or, click Unselect All to clear all check boxes so that no
reports are selected.

❏ Click Generate Reports. The system displays the first report selected. Review the report.

❏ Click Continue to view the next report. Or, click Return to return to the reports selection page.

❏ Click Process to move forecast records to the current year. You are prompted to create an export.

Click Yes to export payroll tables to internal database tables.
Click No to continue the process without creating an export.

A message is displayed indicating that the update and export were processed successfully. The
internal export is now listed on the Payroll > Utilities > Import HR Tables from Database Tables
page and can be selected to be imported.

https://help.ascendertx.com/business/doku.php/general/printreport
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❏ Click Cancel to return to the Move Forecast to CYR Position and Payroll page without moving the
forecast records to the current year.
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Move Forecast to NYR Payroll - HRS6270

Position Management > Utilities > Move Forecast to NYR Payroll

This utility is used to move select groups of payroll forecast records to the next year based on the
selection criteria entered. Once payroll forecast records are moved to next year, end-of-year
accruals can be processed.

You must be logged on to a next year pay frequency to access this utility.

Only occupied positions within forecast can be moved to next year payroll.

Employees with end-of-year accruals that have been calculated to determine if the create General
Journal step has been performed will not be moved.

This utility does not update the Percent Day Employed field on the Personnel > Maintenance >
Employment Info tab.

PMIS Overtime Notes

If the employee’s position record has hours per day, the following overtime calculation is
used: overtime rate = (daily rate / hours per day) * 1.5, hourly rate = (daily rate / hours per
day).
If the employee’s position record hours per day is zero and the job code table has FTE Hours,
the following overtime calculation is used: overtime rate = (daily rate / (fte hours / 5) * 1.5,
hourly rate = (daily rate / (fte hours / 5).
If the employee’s position record hours per day is zero and the job code table has zero FTE
Hours, the following overtime calculation is used: overtime rate = (daily rate / standard hrs) *
1.5, hourly rate = (daily rate / standard hrs).

Move forecast records to next year payroll:

Field Description
Select Pay Frequency By default, this field is set to the year in which you are logged on.

Click  to select a different pay frequency. This is a required
field.

Update TRS Year Flag By default, this field is not selected. Select Update TRS Year
Flag to update the TRS Year field as set on the Staff/Job Pay
Data > Job Info tab. The TRS Year field is used to indicate those
employees whose contract year begins in July or August
(nonstandard) and who receive a contract payment before the
beginning of the school year.

Select First Pay Date Codes or
blank for ALL

Type the pay date codes, separating multiple pay date codes
with a comma but no space (e.g., 1,17,88,A1). Or, click  to
search for pay date codes. Otherwise, leave blank to use all pay
date codes.

https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
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Field Description
Include Extra Duty Select to include extra duty in the process. If not selected, no

extra duty will be processed even if extra duty codes are
selected.

Select Extra Duty Codes or
blank for ALL

Type the extra duty codes, separating multiple extra duty codes
with a comma but no space (e.g., 08,20,A2,TF). Or, click  to
search for extra duty codes. Otherwise, leave blank to use all
extra duty codes.

Select Positions or blank for
ALL (Includes ALL billets for
selected positions Blank for
ALL not processed when
Positions/Billets selected)

Type the position codes, separating multiple position codes with
a comma but no space (e.g., PRIN,T187). Or, click  to search for
position codes. Otherwise, leave blank to use all position codes.

Select Positions/Billets or
blank for ALL

Type the position/billet codes, separating multiple position/billet
codes with a comma but no space (e.g., PRIN/00001,PRIN/00006).
Or, click  to search for position/billet codes. Otherwise, leave
blank to use all position/billet codes.

Select Supplement Positions or
blank for ALL (Includes ALL
billets for selected supplement
positions Blank for ALL not
processed when
Supplements/Billets selected)

Type the supplement position codes, separating multiple
supplement position codes with a comma but no space (e.g.,
PRIN,T187). Or, click  to search for supplement position codes.
Otherwise, leave blank to use all supplement position codes.

Select Supplement
Positions/Billets or blank for
ALL

Type the supplement position/billet codes, separating multiple
supplement position/billet codes with a comma but no space
(e.g., PRIN/00001,PRIN/00006 ). Or, click  to search for
supplement position/billet codes. Otherwise, leave blank to use
all supplement position/billet codes.

❏ Click Execute to execute the process.

The following reports are available:

Move Forecast Process Error Listing
Update NYR Payroll From Forecast by Employee Name
Update NYR Payroll From Forecast by Campus

❏ Click Select All to select all reports. Or, click Unselect All to clear all check boxes so that no
reports are selected.

❏ Click Generate Reports. The system displays the first report selected. Review the report.

❏ Click Continue to view the next report. Or, click Return to return to the reports selection page.

❏ Click Process to move the forecast records to next year. You are prompted to create an export.

Click Yes to export next year payroll tables to internal database tables.
Click No to continue the process without creating an export.

A message is displayed indicating that the update and export were processed successfully. The
internal export is now listed on the Payroll > Utilities > Import HR Tables from Database Tables
page and can be selected to be imported.
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❏ Click Cancel to return to the Move Forecast to NYR Payroll page without moving the forecast
records to next year.
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Retro Pay Processing - HRS6280

Position Management > Utilities > Retro Pay Processing

This utility is used to perform retro pay processing. You must be logged on to a next year pay
frequency to access this utility.

Create an export using Export PMIS Tables prior to using this utility.

PMIS Overtime Notes

If the employee’s position record has hours per day, the following overtime calculation is
used: overtime rate = (daily rate / hours per day) * 1.5, hourly rate = (daily rate / hours per
day).
If the employee’s position record hours per day is zero and the job code table has FTE Hours,
the following overtime calculation is used: overtime rate = (daily rate / (fte hours / 5) * 1.5,
hourly rate = (daily rate / (fte hours / 5).
If the employee’s position record hours per day is zero and the job code table has zero FTE
Hours, the following overtime calculation is used: overtime rate = (daily rate / standard hrs) *
1.5, hourly rate = (daily rate / standard hrs).

Process retro pay:

Field Description
Select Pay Frequency Click  to select the pay frequency that you wish to move to

current year. This is a required field.
Validate Accounts against
General Ledger

By default, this field is selected. Clear Validate Accounts against
General Ledger to not validate the accounts against the general
ledger.

Select First Pay Date Codes Type the pay date codes, separating multiple pay date codes with
a comma but no space (e.g., NY4,NY6). Or, click  to search for
pay date codes.

Include Extra Duty Select to include extra duty in the process. If not selected, no extra
duty will be processed even if extra duty codes are selected.

Select Extra Duty Codes or
blank for ALL

Type the extra duty codes, separating multiple extra duty codes
with a comma but no space (e.g., 08,20,A2,TF). Or, click  to
search for extra duty codes. Otherwise, leave blank to use all extra
duty codes.

Select Positions or blank for
ALL (Includes ALL billets for
selected positions)

Type the position codes, separating multiple position codes with a
comma but no space (e.g., PRIN,T187). Or, click  to search for
position codes. Otherwise, leave blank to use all position codes.

Select Positions/Billets or
blank for ALL

Type the position/billet codes, separating multiple position/billet
codes with a comma but no space (e.g., PRIN/00001,PRIN/00006).
Or, click  to search for position/billet codes. Otherwise, leave
blank to use all position/billet codes.
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Field Description
Select Supplement Positions
or blank for ALL (Includes
ALL billets for selected
supplement positions)

Type the supplement position codes, separating multiple
supplement position codes with a comma but no space (e.g.,
PRIN,T187). Or, click  to search for supplement position codes.
Otherwise, leave blank to use all supplement position codes.

Select Supplement
Positions/Billets or blank for
ALL

Type the supplement position/billet codes, separating multiple
supplement position/billet codes with a comma but no space (e.g.,
PRIN/00001,PRIN/00006). Or, click  to search for supplement
position/billet codes. Otherwise, leave blank to use all supplement
position/billet codes.

Select Extra Duty Code for
Position Retro Pay

Type the extra duty code (e.g., 11). Or, click  to search for an
extra duty code.

Select Extra Duty Code for S-
Type Supplement Position
Retro Pay

Type the S-type extra duty code (e.g., ST). Or, click  to search for
an S-type extra duty code.

Select Extra Duty Code for B-
Type Supplement Position
Retro Pay

Type the B-type extra duty code (e.g., BT). Or, click  to search for
a B-type extra duty code.

Select Extra Duty Code for T-
Type Supplement Position
Retro Pay

Type the T-type extra duty code (e.g., TT). Or, click  to search for
a T-type extra duty code.

Select the Pay date to be
used for Payroll Transmittals

Type the pay date code, or click  to search for pay date codes. If
the Select the Pay date to be used for Payroll Transmittals
field is blank, the next available pay date for the selected pay
frequency will be used.

❏ Click Execute to execute the process.

The following reports are available:

Retro Pay Process Error Listing
Retro Pay - Update CYR Positions From Forecast
Retro Pay - Update CYR Payroll From Forecast by Employee Name
Retro Pay - Update CYR Payroll From Forecast by Campus ID
Retro Pay Processing Payroll Transmittals

❏ Click Generate Reports. The system displays the first report selected. Review the report.

❏ Click Continue to view the next report. Or, click Return to return to the reports selection page.

❏ Click Process to proceed. You are prompted to create a backup.

After the export process is completed, the actual update is performed. If the update is successful,
a message indicating that the retro pay update was processed successfully is displayed.

❏ Click Cancel to return to the Retro Pay Processing page without processing.
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Salary Simulation

Use the Table of Contents to access a page.
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Deductions - HRS6250

Position Management > Utilities > Salary Simulation > Deductions

This tab is used to designate estimated employee and employer annual amounts for deductions.
PMIS does not use the next year Staff Job/Pay Data; therefore, employee deductions are not
available for budgeting. Vacant positions can also be included in the simulation.

The intent of the employee amount is to have an annual estimated value of deductions that are
subject to a Cafeteria Plan 125 that affects FICA/Medicare tax calculations for budgeting purposes.
The employer amount is intended for those deductions where employer contribution needs to be
budgeted. The simulation looks at the current year payroll to detect which employees have that
deduction code, and takes the amount reflected in the Emp Amt field on this tab and reduces the
employee annual gross on the simulation by that amount for those employees who occupy
positions in the next year PMIS to determine the amount of FICA/Medicare that needs to be
calculated for Budget. This field is optional; however, leaving it blank will over budget for FICA and
Medicare, which may be preferred by some LEAs.

You must be logged on to a next year pay frequency to access this utility.

Designate or add a deduction code:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Click Retrieve.

Simulation Name Display only and indicates the simulation name as entered in the Simulation
Name field at the top of the page.

Description Display only and indicates the simulation description as entered in the
Simulation Description field at the top of the page.

❏ Click Deductions to select a fund from the Deductions lookup.

❏ Click +Add to add a row.

Deduction Code Type a three-digit code identifying the deduction. This code must exist in the
Deduction Code table.

Type Indicates the two-character code identifying the deduction and is automatically
populated based the Deduction Code field.

Long Description Indicates the long name that best describes the deduction code and is
automatically populated based on the Deduction Code field.
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Emp Amt Type the annual amount of the contribution by the employee with that
deduction.

Emplr Amt Type the annual amount of the contribution by the LEA for the employee with
that deduction.

Apply to Vacant
Position

Select to apply the employer amount to vacant positions included in the
simulation.
Note: If your TRS Active-Care is split between more than one payroll deduction
code, only select this field for one of the deduction codes. For example, if you
have four TRS Active-Care codes and each one has an annual amount of $2700
for the employer contribution and you select this field for all four codes, then
each vacant position in your reports will reflect a budget amount of $10,800 for
health insurance.

❏ Click Save.
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Delete Simulations - HRS6250

Position Management > Utilities > Salary Simulation > Delete Simulations

This tab is used to delete simulation tables. The Delete Simulations tab is not a required step in the
simulation process.

You must be logged on to a next year pay frequency to access this utility.

Prior to using this utility, create an export using the Position Management > Utilities > Export PMIS
Tables page.

Delete existing simulation tables:

❏ All available simulations are displayed on the left side of the page. Use the arrow buttons to select
the simulations to be updated.

 - Click to move selected entries from the left side to the right side of the page.

 - Click to move all entries from the left side to the right side of the page.

 - Click to move selected entries from the right side to the left side of the page.

 - Click to move all entries from the right side to the left side of the page.

❏ Select the simulations to be deleted.

❏ Click Execute to delete the selected simulation(s).
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Extra Duty - HRS6250

Position Management > Utilities > Salary Simulation > Extra Duty

This tab is used to automatically reference the correct extra duty salary for employees based on
their extra duty codes. This table can be utilized to alter simulations for those pay rates for part-
time functions required at each campus or LEA (e.g., Cheerleader Sponsor, and UIL events).

You must be logged on to a next year pay frequency to access this utility.

Set up extra duty salary data:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Under Records:

Sim Name Displays the simulation name as entered in the Simulation Name field at the top of
the page.

Descr Displays the simulation description as entered in the Simulation Description field at
the top of the page.

Extra Duty
Cd

Type the appropriate extra duty code for the current simulation, or click  to select
the extra duty code from a list.

❏ Click Retrieve. The extra duty code data is displayed.

❏ Click Extra Duty to select an extra duty code from the Extra Duty lookup. Or, create new entries to
be included in the simulation phase.

❏ Under Modify, select either of the following criteria to modify extra duty salaries:

By Percent
By Dollar Amt

❏ Under Salary:

Amount Type the dollar or percentage value to increase a salary. The dollar amount can be a
maximum of six digits (e.g., 9999.99).

❏ Click Default to apply the amount entered in the Amount field to each salary.
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Note: Only the rows without a value in the % Increase or Amount Increase columns are
affected when applying the default values.

❏ Click +Add to add a row.

Extra Duty Cd Type the extra duty code. The field can be a maximum of two characters.
Description Type the name that best describes the code. The field can be a maximum of 16

characters.
Account Code An edit mask allows you to type the full 20-digit account number, mask the

organization code, or mask the whole account number. If the organization code is
masked, when extra duty is assigned to the employee, the organization code
from the employee record would complete the code. If the entire code is masked,
when extra duty is assigned to the employee, a complete account code must be
entered on the distribution record for the employee.

Activity Click  to select a PEIMS activity code and corresponding description.
Wholly Sep Click  to select whether the extra duty salary is subject to the Above State

Minimum Salary Calculations of the TRS 373 Report.
Exp 373 Click  to select whether the amount is to be distributed for the above state

base.
Acct Type Click  to select an account type that best identifies the type of salary. The

Acct Type field is a required field and must be populated to save entries in the
table.

W/C Cd Click  to select the workers' compensation code.
Incl Suppl Dock
Rate

Display only and indicates if the supplemental extra duty amount is included in
the simulation or not.

The Amount field is populated with the salary amount authorized for this extra duty assignment from
the next year extra duty table.

Note: Each row can only be changed by a percent or dollar amount, not both, and if a row
previously had a value entered in the Amount Increase column, and a value is entered in the %
Increase column, the Amount Increase column changes to zero.

% Increase Type the percentage of the increase.
Amount Increase Type the dollar amount of the increase.
New Amount This field is calculated by the system.
Suppl Extra Days If the extra duty will be used for extra days that the employee works, type the

number of additional days to be used for the simulation.

If this field is updated, the amount for any extra days worked is calculated. And, if
the supplemental position is tied to the employee's regular position, the amount
is calculated based on the daily rate of the regular position.

❏ Click Refresh Totals to recalculate the new amounts when a new amount or percent is entered.

❏ Click Save.
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First Pay Date Codes - HRS6250

Position Management > Utilities > Salary Simulation > First Pay Date Codes

This tab is used to designate positions to be included in the simulation based on first pay date
codes. 

You must be logged on to a next year pay frequency to access this utility.

Set up first pay date codes:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Click Retrieve. The simulation is retrieved.

Simulation Name The simulation name is displayed.
Simulation Description The description of the current simulation is displayed.

❏ Click First Pay Dt Cds to select a fund from the First Pay Date Codes lookup.

❏ Click +Add to add a row.

First Pay Date Code Type a unique pay date code. The field can be a maximum of three
characters.

Date of Pay This field is display only and indicates the starting pay date.

❏ Click Save.
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Fund/Fiscal Year Exclusions - HRS6250

Position Management > Utilities > Salary Simulation > Fund/Fiscal Year Exclusions

This tab allows you to designate which funds should not be included in updates to budget (if
Update Budget is selected on the Position Management > Utilities > Salary Simulation >
Simulation Options tab).  If no funds are selected, all funds are available for the update.

You must be logged on to a next year pay frequency to access this utility.

Create an exclusion:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Click Retrieve. The simulation is retrieved.

Simulation Name The simulation name is displayed.
Simulation Description The description of the current simulation is displayed.

❏ Click Budget Funds to select a fund from the Budget Funds/Fiscal Years lookup.

❏ Click +Add to add a row.

Fund/Fiscal Years Type the fund code and the fiscal year. The fund code can be any digit between
101-999, and the fiscal year is a one-digit code that is the last digit in the fiscal
(school) year.

❏ Click Save.

Create an exclusion:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Click Retrieve. The simulation is retrieved.
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Simulation Name The simulation name is displayed.
Simulation Description The description of the current simulation is displayed.

❏ Click Budget Funds to select a fund from the Budget Funds/Fiscal Years lookup.

❏ Click +Add to add a row.

Fund/Fiscal Years Type the fund code and the fiscal year. The fund code can be any digit between
101-999, and the fiscal year is a one-digit code that is the last digit in the fiscal
(school) year.

❏ Click Save.
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Hourly/Daily - HRS6250

Position Management > Utilities > Salary Simulation > Hourly/Daily

This tab is used to automatically reference the correct hourly/daily salary for positions, based on
their pay grade, pay step, max days employed, and local schedule code. This table can then be
utilized to alter simulations for those positions, such as teachers, paraprofessionals, maintenance,
bus drivers, and other jobs as maintained by the district.  

You must be logged on to a next year pay frequency to access this utility.

Set up hourly/daily salary data:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Click Retrieve. The hourly/daily salary data is displayed.

❏ Under Records:

Field Description
Sim Name Displays the simulation name as entered in the Simulation Name field at the top of the

page.
Descr This field is populated automatically with the simulation description as entered on the

Simulation Options tab.
Pay Grade Click  to select the appropriate pay grade for the current simulation. This option limits

your selection.

Note: In addition, you can click the Hourly/Daily button to retrieve and select multiple
pay grades from the hourly/daily table, or create new entries to be included in the
simulation phase.

❏ Click Retrieve. The hourly/daily salary data is displayed.

❏ Under Modify, select either of the following criteria to modify hourly/daily salaries:

By Percent
By Dollar Amt

❏ Under Salary:

Amount Type the dollar or percentage value to increase a salary. The dollar amount can be a
maximum of six digits (e.g., 9999.99).
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❏ Click Default to apply the amount entered in the Amount field to each salary.

Note: Only those rows that have no value in the % Increase or Amount Increase columns are
affected when applying the default values.

❏ Click +Add to add a row.

Pay Grade Type the code for the pay grade. The field can be a maximum of three characters.
Pay Step Type the code for the salary level within the indicated pay grade. The field can be a

maximum of two characters.
Rate Type This field is populated by the system:

If the Hrs Per Day field is left blank, the rate type is set to the daily rate.

If the Hrs Per Day field contains hours, the rate type changes to hourly.
Pay Type Displays the type of pay for the selected simulation.
Hrs Per Day Indicates how the rate is paid. If hours are not zero, the rate is considered an hourly

rate.
Local Sched Type the optional, locally assigned, single-character code that is used to indicate the

separate pay schedules for professional and support staff with the same pay grade,
pay step, and maximum number of days employed.

Est Ovtm Hrs Displays the estimated annual number of overtime hours allowed for this pay grade
and step.

The system populates the Amount field with the hourly/daily salary amount authorized for this pay
grade and step from the Hourly/Daily NYR table.

Note: Each row can only be changed by a percent or dollar amount, not both, and if a row
previously had a value entered in the Amount Increase column, and now a value is entered in
the % Increase column, the Amount Increase column changes to zero.

% Increase Type the percentage of the increase.
Amount Increase Type the dollar amount of the increase.
New Amount This field is calculated by the system.

❏ Click Refresh Totals to recalculate the new amounts when a new amount or percent is entered.

❏ Click Save.
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Local Annual - HRS6250

Position Management > Utilities > Salary Simulation > Local Annual

This tab is used to automatically reference the correct annual salary for employees, based on their
pay grade, pay step, max days employed, and local schedule code. This table can be utilized to
alter simulations for those employees, such as teaching staff, whose pay is based on an annual
amount with step increases for years of service.

Set up local annual salary data:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Under Records:

Simulation Name Display only and indicates the simulation name as entered in the Simulation
Name field at the top of the page.

Description Display only and indicates the simulation description as entered in the
Simulation Description field at the top of the page.

Pay Grade Click  to select the appropriate pay grade for the current simulation. This option
limits your selection.

Local Annual Click to retrieve and select multiple pay grades from the annual salary table, or
create new entries to be included in the simulation phase.

❏ Click Retrieve. The local annual salary data is displayed.

❏ Under Modify, select either of the following criteria to modify local annual salaries:

By Percent
By Dollar Amt

❏ Under Salary:

Amount Type the dollar or percentage value to increase a salary. The dollar amount can be a
maximum of six digits (e.g., 9999.99).

❏ Click Default to apply the amount entered in the Amount field to each salary.

Note: Only those rows that have no value in the % Increase or Amount Increase columns are
affected when applying the default values.

https://help.ascendertx.com/business/lib/exe/detail.php/images/smallpicklist.gif?id=positionmanagement%3Autilities%3Asalarysimulation%3Alocalannual
https://help.ascendertx.com/business/lib/exe/detail.php/images/smallpicklist.gif?id=positionmanagement%3Autilities%3Asalarysimulation%3Alocalannual
https://help.ascendertx.com/business/lib/exe/detail.php/images/ascender_picklist.jpg?id=positionmanagement%3Autilities%3Asalarysimulation%3Alocalannual


Business

2024/05/14 22:26 37 Position Management: Utilities

❏ Click +Add to add a row.

Note:  When adding a new row with +Add, the same pay grade, pay step, local schedule, and
maximum days employed must exist in the NYR Local Annual Salary Table, or the record cannot
be saved.

Pay Grade Type the code for the pay grade. The field can be a maximum of three characters.
Pay Step Type the code for the salary level within the indicated pay grade. The field can be

a maximum of two characters.
Max Days
Employed

Type the maximum number of days worked at the indicated pay grade and pay
step. The field can be a maximum of three characters.

Local Sched Type the optional, locally assigned, single-character code that is used to indicate
the separate pay schedules for professional and support staff with the same pay
grade, pay step, and maximum number of days employed.

The system populates the Annual Amt field with the annual salary for this pay grade and step from
the Local Annual NYR table.

Note: Each row can only be changed by a percent or dollar amount, not both, and if a row
previously had a value entered in the Amount Increase column, and now a value is entered in
the % Increase column, the Amount Increase column changes to zero.

% Increase Type the percentage of the increase.
Amount Increase Type the dollar amount of the increase.
New Amount This field is calculated by the system.

❏ Click Refresh Totals to recalculate the new amounts when a new amount or percent is entered.

❏ Click Save.
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Midpoint - HRS6250

Position Management > Utilities > Salary Simulation > Midpoint

This tab is used to manage the pay rates for hourly, noncontract employees, and contract
employees not covered under the Annual or Hourly/Daily salary tables.

Midpoint Salary Schedule

Set up midpoint salary data:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Under Records:

Sim Name Display only and indicates the simulation name as entered in the Simulation Name
field at the top of the page.

Descr Display only and indicates the simulation description as entered in the Simulation
Description field at the top of the page.

Pay Grade Click  to select the appropriate pay grade for the current simulation. This option will
limit your selection.

Note: In addition, you can click the Midpoint button to retrieve and select multiple pay
grades from the midpoint table, or create new entries to be included in the simulation
phase.

❏ Click Midpoint to retrieve and select multiple pay grades from the midpoint table, or create new
entries to be included in the simulation phase.

❏ Click Retrieve. The midpoint salary data is displayed.

❏ Under Modify, select either of the following criteria to modify midpoint salaries:

By Percent
By Dollar Amt

❏ Under Salary:

Minimum Type the percentage or dollar amount each row will increase by.
Maximum Type the percentage or dollar amount each row will increase by.
Midpoint Type the percentage or dollar amount each row will increase by.

https://help.ascendertx.com/business/doku.php/general/otherhelpfuldocuments/midpointsalaryschedule
https://help.ascendertx.com/business/lib/exe/detail.php/images/smallpicklist.gif?id=positionmanagement%3Autilities%3Asalarysimulation%3Amidpoint
https://help.ascendertx.com/business/lib/exe/detail.php/images/smallpicklist.gif?id=positionmanagement%3Autilities%3Asalarysimulation%3Amidpoint
https://help.ascendertx.com/business/lib/exe/detail.php/images/dropdown.gif?id=positionmanagement%3Autilities%3Asalarysimulation%3Amidpoint


Business

2024/05/14 22:26 39 Position Management: Utilities

Max Pct Pay Inc Type the maximum percentage allowable for the simulation.
Midpt Pct Pay Inc Type the maximum midpoint percentage allowable for the simulation.

❏ Click Default to apply the amounts entered in the Minimum, Maximum, and Midpoint fields to
each row.

Note: Only those rows that have no value in the % Increase or Amt Increase columns are
affected when applying the default values.

❏ Click +Add to add a row.

Pay Grade Type the locally assigned, three-character code for the pay grade.
Pay Type Click  to select a of pay type code.
Hours Type the number of hours authorized for this pay grade.

When pay types 1, 2, and 4 are calculated as daily rates, the Hours field is left blank.

When pay type 3 is calculated on an hourly pay rate, the Hours field requires a value.

The system populates the Minimum field with the lowest pay rate for this pay grade/pay type from
the Midpoint NYR table.

Note: Each row can only be changed by a percent or dollar amount, not both, and if a row
previously had a value entered in the Amount Increase column, and now a value is entered in
the % Increase column, the Amount Increase column will change to zero.

% Increase Type the percentage of the increase.
Amt Increase Type the dollar amount of the increase.
New Min This field is calculated by the system.

The system populates the Maximum field with the highest pay rate for this pay grade/pay type from
the Midpoint NYR table.

% Increase Type the percentage of the increase.
Amt Increase Type the dollar amount of the increase.
New Max This field is calculated by the system.

The system populates the Midpoint field with the calculated midpoint pay rate for this pay grade/pay
type from the Midpoint NYR table.

% Increase Type the percentage of the increase.
Amt Increase Type the dollar amount of the increase.
New Midpoint This field is calculated by the system.
Max Pct Pay Inc Type the maximum percentage allowable for the simulation.
Midpt Pct Pay Inc Type the maximum midpoint percentage allowable for the simulation.
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Max Inc/Dec Amt This field is calculated by the system.
Midpnt Inc/Dec Amt This field is calculated by the system.

❏ Click Refresh Totals to recalculate the new amounts when a new amount or percent is entered.

❏ Click Save.
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Simulation Options - HRS6250

Position Management > Utilities > Salary Simulation > Simulation Options

The Salary Simulation menu is only available when logged on to a next year pay frequency.

Create an export using Utilities > Export PMIS Tables prior to using this tab.

This tab is used to create a forecast position salary simulation and to select the parameters
associated with the simulation.

The simulation will process for positions where the school year matches the Next Year field on the
District Administration > Options > Position Management tab and where the accept changes flag is
selected for forecast records.

Each simulation will have a unique, user-assigned name and may have various salary types
included in the simulation.

When the salary calculations are performed, the program will use the original salary amount from
the next year salary table, and then apply the percent or amount change as defined in the
associated simulation table for that salary to determine the new salary amount for that pay grade
and pay step.

Steps that have a zero percent or amount increase are included in the salary calculations at the
rate from the original next year salary table amounts.

Salary Simulations provide budget reports without the need to overlay any employee or position
data in the NYR payroll. Reports are available after the simulation calculations have been
processed.

If the Recalculate field is selected for a supplement position on the Maintenance > PMIS
Supplement Modify or PMIS Supplement Admin pages, and the position is not based on a regular
position, the salary table amount for the extra duty is applied to the position record. If the
Recalculate field is not selected, the salary amount in the supplement position is not changed.

403B FICA Alternative contribution calculations - PMIS simulation calculations now include
403B FICA Alternative contribution calculations when the A3 deduction type is included on the
Deductions tab for the selected simulation. And, the deduction code for the A3 deduction type
exists for an employee included in the simulation. The reports will list the account codes and
amounts in the annuities column.

Create a simulation:

Field Description
Simulation Name Type the name of a simulation or click  to select the simulation name

from a list.
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Field Description
Simulation Description Type a description of the current simulation or click  to select the

simulation description from a list. The field can be a maximum of 30
characters.

❏ Click Retrieve. The simulation is retrieved.

Simulation Name If retrieving an existing simulation, the simulation name is displayed. If
adding a new simulation, type the simulation name.

Simulation
Description

The description of the current simulation is displayed. If adding a new
simulation, type the new simulation description.

User ID This field is populated per user per simulation.

❏ Click Add Simulation to create a new simulation.

❏ Under Calculation Options:

Include Proposed
Positions

Click  to select Yes or No to budget for the proposed positions to
determine if they are affordable. This is a required field.

Include Vacant
Supplement Positions

Click  to select Yes or No to budget for the vacant supplement
positions to determine if they are affordable. This is a required field.

Note: Forecast always budgets for a vacant regular position.
Increment Pay Steps Click  to select Yes or No to increment the pay steps in the simulation.

This is a required field.

Note:  If salaries will be frozen, the salary increase should be set to 0%,
and the step salary schedule should be changed by moving the amounts
from one step to another.

Maximum Annual Pay
Step

Type the two-character code for the highest pay step in your local annual
salary schedule. The field is used to identify the correct salary amount on
the salary table.

Maximum Hourly/Daily
Pay Step

Type the two-character code for the highest pay step in your hourly/daily
salary schedule. The field is used to identify the correct salary amount on
the salary table.

Increment State Steps Click  to select Yes or No  to increment the state steps in the
simulation. The state steps automatically max out at 20. This is a
required field.

Include TRS On-Behalf
Calculations

Click  to select Yes or No  to include the TRS on-behalf calculations in
the simulation. This is a required field.

Expenditure Account
for TRS On-Behalf
Calculations

Type an account code to be used as an expenditure account for the TRS
on behalf calculations. The object code is always 6144 and must be
distributed by function so the function must be XX. The LEA can
determine other account code components.
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For Midpoint Salaries -
Basis of Salary Change

Click  to select one of the following options:
C - Use position hrly/dly rate - Select to calculate the percentage increase
for midpoints on the actual existing rate. This option is used by LEAs that
are using a midpoint schedule in place of putting employees on a salary
schedule.

T - Use Simulation Mid Inc/Dec Amt - Select to base the percentage on
the midpoint. This option is used by LEAs that follow a midpoint schedule.
Select to calculate the percentage increase for midpoints on the actual
existing rate. This option is used by LEAs that are using a midpoint
schedule in place of putting employees on a salary schedule.
This is a required field.

For Midpoint Salaries -
Increase Pay Rate to
Minimum

Click  to select Yes or No to increase or not increase the pay rate to
minimum for midpoint salaries. This is a required field.
If Yes is selected, the pay rate is increased to the minimum amount if it is
below the minimum amount, and then the pay rate raise is applied per
the simulation. This ensures that employees are not paid less than the
minimum.
If No is selected, the pay rate raise is applied per the simulation, and
then the pay rate is raised to the minimum amount if it is still below the
minimum amount.
Example
Example 1:
If an employee's current pay rate is $47, the simulation is set up for a 1%
increase on midpoint, and the midpoint table amounts are set up as
follows: $50 minimum $75 midpoint $100 maximum
If Yes is selected, the pay rate is updated to $50.75, which is an increase
to $50 (the minimum) plus 1% (.75) of $75.
If No is selected, add 1% (.75) of $75 to the current pay rate of $47,
which is below the minimum so the pay rate is updated to $50.
Example 2:
If an employee's pay rate is $49.50, and all of the factors are the same as
in example 1:
If Yes is selected, the employee's new pay rate is $50.75.
If No is selected, the employee's new pay rate is $50.25.

Include TEA Health
Insurance

Click  to select Yes or No to include or not include TEA health insurance
in the simulation. This is a required field.

❏ Under Update Options:

Update for Active
Positions Only

Click  to select one of the following options:
A - Calculate Budget Based on Vacancy Data
B - Move Actual Amount to Budget Amount
C - Move Actual Amount to Budget if Actual > Budget
This is a required field.

Update Forecast Click  to select Yes or No to update or not update the forecast in the
simulation.

Only select Yes when you are ready to secure all of the positions and apply
the increase and updates to next year positions. This option moves the
simulations into the next year positions, and if selected, the pay and state
step increase is updated.

This is a required field.
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Update Budget Click  to select one of the following options:
N - Do not update Budget
I - Increase or add to the amounts in Budget
R - Replace the amounts in Budget (This is how next year payroll to next
year budget works.)
This is a required field.

Update Budget
Amount

Click  to select one of the following options:
R - Recommended Amount
A - Approved Amount
This is a required field.

❏ Click Execute to begin the simulation process.

❏ Under Calculation Reports:

Select the report(s) from the list. Click Select All or Unselect All to select all of the reports or
unselect all reports.
Click Generate Reports. The reports are displayed in the order selected.

❏ Click Process to save the data to budget and/or PMIS records based on the Update Options
selected. You are prompted to create a backup.

Review the report.

❏ Click Continue to continue to the next report.

❏ Click Return to return to the Calculation Reports page and skip the display of the remaining
reports selected.

Duplicate a simulation:

The Duplicate From Simulation field and Duplicate button are only visible when you click Add
Simulation.

Duplicate From Simulation Type the name of a simulation, or click  to select a simulation name
from a list.

❏ Click Duplicate to duplicate the simulation.

Delete a simulation:

❏ Click Delete to delete the displayed simulation.
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Update Salary Tables- HRS6250

Position Management > Utilities > Salary Simulation > Update Salary Tables

This tab is used to select the simulation records to update the next year salary data. All simulations
that will be updated in the next year tables need to be updated at one time. Once the update
process has been completed, the process is disabled until the Copy CYR Tables to NYR Tables
process is completed again.

It is your responsibility to ensure the simulation has not been updated multiple times, causing the
salary tables to be incorrect. It is also important to maintain the integrity of the simulation tables to
prevent duplicated steps.

You must be logged on to a next year pay frequency to access this utility.

Update existing salary tables:

❏ All available simulations are displayed on the left side of the page. Use the arrow buttons to select
the simulations to be updated.

 - Click to move selected entries from the left side to the right side of the page.

 - Click to move all entries from the left side to the right side of the page.

 - Click to move selected entries from the right side to the left side of the page.

 - Click to move all entries from the right side to the left side of the page.

❏ Click Execute.

If any errors are encountered during the process, an error report is displayed. A listing of all
duplicates and rows in the simulation that are not listed in the salary table is displayed. All simulation
update processes are disabled until you clear the errors.

Review the report.

❏ Click Continue.

❏ Click Cancel to close the report and return to the Update Salary Tables tab.

If no errors are encountered during the process or you clicked Continue from the error report, a
report for each of the four salary tables is generated.

❏ Click Cancel to return to the Update Salary Tables tab without updating.
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❏ Click Process to process the update. You are prompted to create a backup.

After the export process is completed, the actual update is performed. If the update is successful,
a message is displayed indicating that the simulation update was processed successfully.
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Update Fiscal Year by Fund - HRS6240

Position Management > Utilities > Update Fiscal Year by Fund

This utility is used to select funds that need an updated fiscal year. When updating the fiscal year
by fund, ensure the payroll frequency matches that of the logged-on payroll frequency. To update
the fiscal year for another payroll frequency (e.g., E - Semimonthly NYR), you must change to that
payroll frequency using the Change Payroll Frequency dialog box.

Position distribution records will be updated based on the logged-on pay frequency. For example:

If you are logged on to a current year pay frequency, current year position management
distribution records are incremented for selected funds.
If logged on to a next year pay frequency, forecast position management records are
incremented for selected funds.

Create an export using Export PMIS Tables prior to using this utility.

Update the fiscal year:

❏ Under Increment Fiscal Year by 1:

Select Increment to increment the fiscal year by one. If Increment is not selected, the fiscal
year is not incremented.
The Fund/Year field is display only and indicates the fund/fiscal year that can be incremented.

Note: The new fund/fiscal year must exist in the current year or Budget of next year.

❏ Click Retrieve to reset all rows with Increment selected to the default setting (e.g., clear the check
boxes). If you click Retrieve, any unprocessed changes are lost.

❏ Click Execute to start the update process. You are prompted to create a backup.

After the export process is completed, the actual update is performed. If the update is successful,
a message is displayed indicating that the update process was completed successfully.
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Vacate Employee from Forecast Positions -
HRS6200

Position Management > Utilities > Vacate Employee from Forecast Positions

This utility is used to remove an employee from all positions that the employee occupies without
performing a change in position (CIP) to remove.

This utility is for forecast records only.

Vacate an employee from forecast positions:

Field Description
Employee Begin typing the employee name or number. As you type the data, a drop-down list of

corresponding data is displayed. Select an employee, and click Retrieve. Or, click  to
perform a search in the Employees directory.
Type data in one or more of the search fields.
Click Search. A list of data that matches the search criteria is displayed.
Select an employee name from the list.
Otherwise, click Cancel.

Vacate Select to vacate the employee from the position currently displayed.

Note:  After selecting positions that should be vacated, click Save, and the employee will
be removed from the position. If the employee has supplement positions and all regular
positions are being vacated, the supplements must be vacated also. If the employee has
multiple regular positions, and not all of the regular positions are being vacated, then
vacating the supplement positions is not required.

❏ Click  to display the detail information for the selected row.

If Accept Chgs is selected, you can choose to vacate the employee from the position.
If Accept Chgs is not selected, the employee cannot be vacated from the position, and Vacate
is not displayed on the page.

Position Type This field is display only and is populated based on the job code.
Position Number This field is display only.
Position Description This field is display only.
Billet Number This field is display only and indicates the five-digit billet number used to

identify the job position within the position number.
Sch YR This field is display only and indicates the school year.
Job Code This field is display only and identifies the job (e.g., 0001 = Superintendent,

1003 = 10 month - 3rd Grade Teacher).
Status This field is display only and indicates the current status of the position.

❏ Click Save to save the changes.
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Vacate Forecast Supplement Positions -
HRS6275

Position Management > Utilities > Vacate Forecast Supplement Positions

This utility is used to clear out the forecast supplement records assigned to an employee. It is
recommended to vacate all supplemental records except supplements that apply directly to an
employee (e.g., career ladder, experience pay, doctorate, degree stipends).

You must be logged on to a next year pay frequency to access this utility.

This utility is for forecast records only.

If updating tables, create an export using Export PMIS Tables prior to using this utility.

Vacate an employee from forecast positions:

❏ Click Select to choose the supplement positions to be vacated. Use the following buttons to select
which supplement positions to move to the right side of the page:

 - Click to move selected entries from the left side to the right side of the page.

 - Click to move all entries from the left side to the right side of the page.

 - Click to move selected entries from the right side to the left side of the page.

 - Click to move all entries from the right side to the left side of the page.

❏ Click Execute to execute the process. The following reports are available:

Vacate Forecast Supplement Positions Process Error Listing
Vacate Forecast Supplement Positions

❏ Click Select All button to select all reports. Or, click Unselect All button is used to clear all check
boxes so that no reports are selected.

❏ Click Generate Reports. The system displays the first report selected. Review the reports.

❏ Click Continue to view the next report. Or, click Return to return to the reports selection page.

❏ Click Process to process the records. You are prompted to create a backup.

After the export process is completed, the actual update is performed. If the update is successful,
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a message indicating that the vacate supplement position update was processed successfully is
displayed.

❏ Click Cancel to return to the Vacate Forecast Supplement Positions page without vacating any
forecast supplement positions.
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